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Quickest way to convert scanned PDF to text on mac 
It has become an undeniable fact that PDF is nowadays more and

more widely used as a popular Internet file formats, which can be

encrypted. However it is not easy to edit to change. Online

documents are now generally taken to this file format. But

sometimes change the content of the pdf, when in trouble. General

pdf reader tool does not modify the pdf documents from scratch.

Such as Adobe reader, foxit reader, and so on ... but some reader

can also modify pdf documents, such as adobe's acrobat reader.

 

So when we occasionally need to edit the scanned PDF files,

particularly when you want to edit some paper files by scanning it

to PDF (which is simple and easy , convenient). When you are

getting a scanned PDF, you could require this content to use in

your computer directly, and a common

pdf

converter pro for mac could not distinguish the file. If you

really should use the content in the scanned PDF, surprisingly this

is pretty easy to do when you have some OCR (Optical character

recognition) converter tool. Free download it first, then follow

the tutorial to convert scanned PDF to text on Mac.

 

How to Convert Scanned PDF Files to TXT on Mac

 

Step 1: Perform OCR

Launch the program, on the bottom window, check the "Convert

scanned PDF documents with OCR" option. Then this software will

automatically perform the OCR.

 

Step 2: Import Scanned PDF Files

On the top menu, click File -> Add PDF Files to import the

scanned PDF files. This software also supports drag-and-drop PDF

files to the main window. This method will save a lot of time for

you.

 

Step 3: Output format settings

Click button next to the PDF files, a window will pop-up,

from the Format drop-down list, select .txt as an output format.

You can also set the page range to meet your needs.

 

Step 4: Convert Scanned PDF to Text on Mac

All settings are OK, simple press Convert button to start

scanned PDF to txt conversion on Mac. Few minutes later, you can



get the converted PDF files on your Mac local. You can open it to

check the quality.

 

Much more useful tips for editing or converting pdf files:

how

to convert pdf to word,

convert

pdf to powerpoint
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Two simply ways to sync iPad on two computers 
Q: Hello. I have an Apple Ipad and Macbook Pro and Imac. The

thing that I want to know is that can I gel up or use the Ipad to

be connected to the Imac or Macbook pro well. Is it possible to

synchronize the device with two different system. It would be a

great help if you can help me out in getting the issue to be

sorted. Thank you.

 

A: If you have an Apple Mobile Device (iPhone, iPad, or iPod

touch) it's actually possible to sync it with multiple computers.

You just have to understand the rules. Apple groups things into

four categories:

 

Data - the data or info category consists primarily of things

like your contacts, calendar, bookmarks, notes, email accounts,

etc. This information can either be sync'd via iTunes or wirelessly

via MobileMe or Microsoft Exchange (although Notes currently can

only be sync'd via iTunes).

 

Media - the media category consists of your music, movies,

music videos, TV shows, podcasts, audiobooks, ringtones, iTunesU

and now iBooks. This content can either be sync'd or managed

manually.

 

Photos - well this category is pretty self explanatory. It's

your photo library and all of your photo albums. Your photos can

either be in iPhoto or simply in a folders and subfolders. (Related

tips: How to

transfer photo from ipod to computer)

 



 

 

Apps - last but certainly not least is your Apps that you've

downloaded from the App Store.

 

 

Method 1: Sync iPad with Two Computers Free

 

 

Step 1: Connect the iPad to your Computer

 

 

Download and install iTunes onto your computer. When you connect

the iPad to your computer, you will notice a warning come up that

says "This iPad is synched with another computer. Do you want to

sync the iPad with this computer? All data will be lost." and then

you have the options of clicking OK or Cancel. Just click

Cancel.

 

 

Step 2: Apply automatic sync

 

 

Select your iPad in the DEVICES section of the iTunes Source

list. In the main iTunes browser window, select the Summary tab.

Select the "Manually manage music and videos" option. Then click

Apply.

 

 

Step 3: Choose files for Syncing

 

 

To manually add music, audiobooks, movies or TV shows to your

iPad, choose one of these categories under LIBRARY in the Source

list. Select and drag items you want (to choose multiple items,

Command-click items on a Mac or Control-click items in Windows),

then drag them onto your iPad icon in the Source list. When you are

ready to disconnect your iPad, select it in the Source list and

click the eject icon.

 

 

Method 2: Sync iPad with Two Computers with Software

 

 

Step 1: Free download and install iStonsoft iPad/iPhone/iPod to

Computer Transfer on your computer on your computer, then connect



your iPad to one computer with data cable.

 

 

Step 2: Select the files you want to sync to computer, here we

take photos as example.

 

 

Step 3: Click  to start syncing iPad to computer. Done!

 

 

Related Guides:

 

How to

transfer ipod to new computer

 

How to get the best

ipod to mac transfer
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The most complete and practical tips and tricks of iphone 4 
Have being using an iphone 4 for several months, but still are

not good at playing with iphone 4? If so, today you have just come

to the right place, here we can provide you a series of tips and

tricks to help you play with iPhone 4 .

 

 

Locate your lost iPhone

 

If you lose your iPhone, "Find My iPhone" can help you locate

it on a map the location and protect the inside data. You can also

display a message on the screen or remotely lock or erase your

data.

 

 

Save the network picture

 

In Safari, tap and hold a picture, you can save it to your

"Camera Roll", or copy and paste it into the MMS or email.

 

Select the "wallpaper" in the "Settings", tap the lock screen



and main screen of the picture, then click on one of your albums,

or click on the "wallpaper" to view the picture of the

Apple-designed. Find you need a picture, click "Settings", then

choose to apply it to "set the lock screen, set the main screen, or

set at the same time" applied to both.

 

 

Quickly scroll to the top

 

The status bar in Safari, Mail, Address Book and many other

applications, tap the top of the screen (display network

information, time, battery location), you can quickly scroll to the

top of the screen.

 

 

Add PDF files to iBooks

 

Tap and hold the Mail, or web page on the PDF icon or link,

and then select "open in iBooks.

 

 

Keep the inbox clean and tidy

 

In Mail, you can batch delete or move messages. Click "Edit"

from your Inbox, select the messages you need to organize, and then

click "Delete" or "mobile".

 

 

Create iPod playlists

 

In the iPod application tap "playlists", then click "Add

playlist" before it a name, and then click on a song or a video,

you can add it to the playlist(hot link:

how

to get songs off ipod onto computer). You can add single songs,

entire albums, or all the songs of an artist.

 

Using iPhone wireless print

 

AirPrint you through your iPhone directly support-AirPrint

the printer easily print the email and web. To print an e-mail,

just tap the "Reply" button, then select "Print". To print a page,

tap the "Action" icon and select "Print". You can also print

photos, documents and other documents.

 

Swipe to delete



 

You do not need to open you can delete the e-mail messages

and text messages. Just swipe in the e-mail or SMS, you can

"delete" button, you can delete the tap.

 

Read the iPhone user manual

 

For more tips, tricks, and instructions, Safari, tap the

Bookmarks icon, select "iPhone manual.

 

 

More hot tips for iphone 4 user reference:

iphone

to computer transfer,

how

to transfer music from iphone to computer
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Things you must have to learn about converting pdf to kindle on mac 
 

Abstract: It is without any doubt that Kindle has

become one of the most popular ebook readers of the world. With so

many devices out in the market, it is quite easy to see that Kindle

is above them all. With statistics claiming the Kindle shipped 2.6M

units worldwide, there is no doubt left. Kindle can handle a lot of

different file formats and it is recommended that you always get a

digital book copy that supports one of the Kindle formats. If you

are not careful with the formats, you may end up with a file that

is not readable on your Kindle.

 

 

What formats can Kindle support?

 

- The 1st generation Kindle: MOBI, PRC, plain text files

(TXT), Topaz format books (TPZ), and Amazon's proprietary

DRM-restricted format (AZW).

- The Kindle 2 added native PDF support with the Version 2.3

firmware upgrade.

- The 4th generation Kindle, Kindle Touch and Kindle Touch 3G



are able to display Kindle (AZW), TXT, PDF, unprotected MOBI, and

PRC files natively.

 

 

Why convert PDF to Kindle Mac?

 

As we can see in the above format lists, PDF can be supported

by Kindle 2, Kindle Touch, but why there are people who need to

convert PDF to Kindle on Mac or Windows computer? This may be not

understood easily. But I do understand. Following are 2 reasons why

people need to convert PDF to Kindle Mac, such as

convert

pdf to text mac.

 

1. Only when Kindle-friendly files, like .mobi and .txt files

are imported to Kindle device, Kindle functions, including,

variable font size, annotation, Text-to-Speech, etc. can be

available for readers.

2. For enhancing or improving the reading experience on

Kindle, MOBI or Txt files are the better options.

 

 

How to convert PDF to Kindle Mac?

 

A really cool, upcoming application has caught our eyes.

iStonsoft

pdf

converter for mac

is an excellent program for converting PDF to ePub, PDF to Word,

PDF to TXT, PDF to Image, etc. It is a small, portable program that

works independently without technical expertise and third party

involvement.

 

To convert PDF to Kindle Mac, here are the step-by-step

instructions you can follow:

 

Preparation work: Free download, install and launch the PDF to

Kindle Converter Mac.

 

 Load PDF file(s)

 

 

There are 3 ways to import PDF files to the software:

 

1) Directly drag and drop the PDF files to the software. The

easiest way.



 

2) Click File -> Add Files... in menu, choose and load PDF

files.

 

3) On the toolbar, click "Add Files" or "Add Folder" button to

load PDF files to the software.

 

 Output settings

 

Output format: The default output format is PDF to HTML. Click

the  button to select TXT as the output format. The output

type in the left list will be changed to Text.

 

 

Output folder: The default is to save output file(s) in the same

folder of input file(s). If you wanna change it, check the

"Customize", and then click the button "Browse" to browse and

locate the folder which you want.

 

 

Start conversion

 

 

To convert all PDF files to Kindle TXT format, click the

"Convert" button on the right bottom corner.

 

To convert one PDF file to Kindle TXT format, right click on one

specific PDF document.

 

 

Sounds easy, doesn't it? Just have a try in person.

 

 

More related articles you maybe interested in:

convert

pdf to word mac
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All things about Calibre ebook reader 0.8.43 updates 



 

 

 Abstract:

 

Calibre is a software program that is developed by a devoted

reader and brilliant programmer, kovidgoyal. The program is free

and open source, available for MAC, Windows PC, and Linux users.

Calibre can also talk to a few e-book reader devices. calibre can

go out to the internet and fetch metadata for your books. calibre

can download newspapers and convert them into e-books for

convenient reading. With it, you don't have to use a

pdf converter to convert the ebook formats to a

great extent.

 

 

 

Calibre stores your ebook files in a database along with

easily editable metadata describing each book. Calibre is designed

around the concept of the logical book, i.e. a single entry in the

database that may correspond to ebooks in several formats. Calibre

is developed in pure Python and it is cross platform, running on OS

X, Linux, and Windows.

 

 

   New Features

 

 

 

  

 

 

 

 1.Template language: Speedup evaluation of general program

 mode templates by pre-compiling them to python. If you experience

 errors with this optimization, you can turn it off via

 Preferences->Tweaks. Also other miscellaneous optimizations in

 evaluating templates with composite columns.

 

 

 MOBI Output: Add an option to not convert all images to

 JPEG when creating MOBI files. For maximum compatibility of the

 produced MOBI files, do not use this option.

 

 

 Closes tickets: 954025  (Related link:

 epub to mobi)



 2.Add iPad3 Output Profile

 

 

 

   Bug Fixes

 

 

 

 KF8 Input: Add support for KF8 files with obfuscated

 embedded fonts

 Closes tickets: 953260 

 

 

  

 

 

 Make the stars in the book list a little larger on windows

 >= vista

 

 

 

 Revised periodical Section layout, for touchscreen devices

 resolving iBooks problem with tables spanning multiple

 pages

 

 

 

 Read dc:contributor metadata from MOBI file.

 

 

  

 

 

 KF8 Input: Recognize OpenType embedded fonts as

 well.

 

 

  

 

 

 Fix regression in 0.8.41 that caused file:/// URLs to stop

 working in the news download system on windows. When setting

 metadata in MOBI files fix cover not being updated if the mobi

 file has its first image record as the cover. (More tips:

 convert mobi to epub)

 



 

 Fix column coloring rules based on the size column not

 working

 ï¼
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iPad 3: Cool accessories For Your New Tablet 
With the iPad 3 finally out in the public, it's only right that

people try to keep their new device safe and sound from different

kinds of harm, such as falls, spills, scratches etc. For some, the

iPad is their life, and they do everything they can to maintain its

shiny look. Not only that, people also buy different accessories

for their iPad's in order to give it a unique look and have an edge

over the other

tablets that are owned by people. Many people

are now interested in finding different accessories for the iPad 3

that they've bought. If you're also one of those people who want to

know about the different accessories that they can get for their

tablets, then you've come to the right post. Know about a list of

accessories meant for your iPad 3 , after the break!

 

Keep on reading if you're interested in knowing how you can

keep your tablets safe, or

why are we so crazy about apple's ipad.

iPad covers, cases and protectors

The best way to keep your iPad safe is by giving it a well-made

cover, case or a protector. There are a lot of items present in the

market and that's why we've listed some good options, by Apple, for

you all to look at.

Smart Cover (£35)

The

smart cover is one of Apple's classics. It

has been designed to keep the screen of the iPad 2, scratch free

and clean. The back of the cover will get scratched, but at least

the Retina display will remain safe.

 

 

 

It's available in a variety of colors, and you can get one from



Apple's

official site.

The iPad satchel (£111)

Having an iPad carrier is also a good thing. Many of the

carriers don't look as if they're for tablets, and they look like

ordinary carriers.

 

 

 

The Ally Capellino

canvas satchel has been specifically designed

for the iPad and you can get it from the

Apple store.

Zagg Invisible Shield (£8)

A good way to keep your iPad 3 safe is by wrapping it completely

in plastic that's scratch resistant. The good thing about the

'Invisible shield' is that it's invisible.

 

 

 

You should get the Zagg Invisible Shield to keep your tablet

safe.

Charging, cables and connectivity

Now you can easily connect, charge, etc. your tablets with the

multitude of devices manufacturers have developed.

Apple Digital AV Adapter (£35)

 

Using this device allows you to send a signal from your iPad

through HDMI. You can even send audio.

 

 

 

You can also get yourself this device if you want to show your

data on a HDMI-capable projector.

Apple TV (£99)

 

With the help of AirPlay, users can push audio and video from

the iPad to the Apple TV and then to the television sets or the

speakers.

 

 

 

You can get Apple TV for only £99.

Apple camera connector kit (£25)

 

This little device is very useful when it comes to connecting



your camera to your tablet. If you have a larger iPad, then you can

use it as a portable camera backup.

 

 

 

Having the Apple camera connector kit is quite useful.
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News of Kindle Fire upgrade-Plus the â??sharing functionâ?? 
 

 According to CNET reports, Amazon has

 begun to push Kindle Fire upgrade,

 

 

 the user can also download firmware 6.3

 from the website updates. The new upgrade share real-time

 function, the user can choose books a page or a paragraph to

 share with friends, can also choose to share to Twitter and

 Facebook. Update will also increase the Book Extras, personal

 documents filed, Amazon Silk model of reading and other

 characteristics

 

 

 The more information you can continue read from the

 following:

 

 

  

 

 

 

 

 

   Reading

 

 

 

 

   view:

 



 

Perhaps the most interesting new feature in the update, from

a Web browsing perspective, is called Reading View for Amazon Silk,

the company's split-architecture Web browser for the Kindle Fire.(

HOT:

convert

epub to kindle)

The Amazon Silk Web browser has been upgraded to

include a "Reading View" option for users that prefer to get to the

text of an article quickly without having to look at other content

on the site like related stories, user comments or banner

advertisements.

 

 

   Book Extras

 

 : Powered by Shelfari, Amazon's community of book lovers,

 Book Extras make it easy for customers to see supplemental

 material about the book they are reading, without even leaving

 the book. Customers can view descriptions of characters, a

 glossary of common terms used in the book, information on the

 authors and common locations referenced in the book, and more. To

 view Book Extras from within a book, customers simply tap the top

 of the screen to bring up the toolbar, tap the menu button and

 select "Book Extras."

 

 

 

   Additional Enhancements

 

 : This update will also bring some of the features

 customers have requested, including faster re-connect of Wi-Fi

 after Kindle Fire has been asleep, and general performance

 enhancements.

 

 

 

   Reading

 

 

   View for Amazon Silk

 

 : There is a seemingly endless array of interesting and

 engaging content available on the Internet. Sometimes,

 unfortunately, that business article, blog post, or sports recap

 you clicked on is surrounded by a host of competing material.



 With Reading View on Silk, the content that you're interested in

 is elevated above the clutter. When invoked by the customer, Silk

 will load the body of the page in a reading-optimized, single

 screen view (even for multi-page articles). The full page is

 still available in the background, allowing the reader to easily

 toggle back to a traditional view to see other interesting

 features on the page.
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News of Kindle Fire upgrade-Plus the â??sharing functionâ?? 
 

 According to CNET reports, Amazon has

 begun to push Kindle Fire upgrade,

 

 

 the user can also download firmware 6.3

 from the website updates. The new upgrade share real-time

 function, the user can choose books a page or a paragraph to

 share with friends, can also choose to share to Twitter and

 Facebook. Update will also increase the Book Extras, personal

 documents filed, Amazon Silk model of reading and other

 characteristics

 

 

 The more information you can continue read from the

 following:

 

 

  

 

 

 

 

 

   Reading

 

 



 

 

   view:

 

 

Perhaps the most interesting new feature in the update, from

a Web browsing perspective, is called Reading View for Amazon Silk,

the company's split-architecture Web browser for the Kindle Fire.(

HOT:

convert

epub to kindle)

The Amazon Silk Web browser has been upgraded to

include a "Reading View" option for users that prefer to get to the

text of an article quickly without having to look at other content

on the site like related stories, user comments or banner

advertisements.

 

 

   Book Extras

 

 : Powered by Shelfari, Amazon's community of book lovers,

 Book Extras make it easy for customers to see supplemental

 material about the book they are reading, without even leaving

 the book. Customers can view descriptions of characters, a

 glossary of common terms used in the book, information on the

 authors and common locations referenced in the book, and more. To

 view Book Extras from within a book, customers simply tap the top

 of the screen to bring up the toolbar, tap the menu button and

 select "Book Extras."

 

 

 

   Additional Enhancements

 

 : This update will also bring some of the features

 customers have requested, including faster re-connect of Wi-Fi

 after Kindle Fire has been asleep, and general performance

 enhancements.

 

 

 

   Reading

 

 

   View for Amazon Silk

 



 : There is a seemingly endless array of interesting and

 engaging content available on the Internet. Sometimes,

 unfortunately, that business article, blog post, or sports recap

 you clicked on is surrounded by a host of competing material.

 With Reading View on Silk, the content that you're interested in

 is elevated above the clutter. When invoked by the customer, Silk

 will load the body of the page in a reading-optimized, single

 screen view (even for multi-page articles). The full page is

 still available in the background, allowing the reader to easily

 toggle back to a traditional view to see other interesting

 features on the page.

 

 

 

 

 

 More tips for ebook reading: how to

 convert

 epub to mobi,

 pdf

 reader mac
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How to Read Ebooks on the iPad with iBooks & Amazon Kindle for mac 
 
 
 As an avid reader of books, I'm finding the
 experience of reading e-books on the 9.7″ screen of the
 iPad worth at least half the price of the device, especially
 after having read about five e-books on the Kindle version for
 the iPhone.
 
 
 
 
 
 
   Downloading
   Books



 
 
 
 Both Amazon
 and Apple allow users to download sample copies of their e-books.
 My decisions to purchase or not purchase an e-book has many times
 been influenced by reading a sample copy first.
 
 
 
 
 
 
   Reading
   E-Books
 
 
 
 Simple reading
 of e-books in both applications is pretty much the same as well.
 In both apps you tap on the right and left side of the iPad
 screen to "turn" pages. Each app includes a little animated
 feature in which if you "turn a page" slowly it replicates the
 look of turning a real paper book. This feature is not
 turned on, I think, by default in the Amazon reader.
 
 
 You can also
 change the font style and size of pages as you read, in both
 readers. Also very useful is the ability to dim the light of the
 backlit screen, which can be done in both apps. If you need to
 look up a word in the dictionary, each app has a tool for
 that.
 
 
 
 
 
 
   Page
   Locations
 
 
 
 The most
 frustrating part of reading in both of these apps is getting lost



 when you turn too many pages.  In iBooks you can move your
 finger across the bottom of each page to select a page number in
 a chapter. Also , the bottom-right side of each page tells you
 how many pages are left in each chapter.
 
 
 The Kindle
 reader is similar, but not as practical. The page numbering in
 the Kindle does not come close to the actual page numbering in
 the paper version of a book. The numbering can go into the
 thousands, when the paper version is actually say 296. And it
 only gives you the percentage of pages read in an e-book.
 
 
 
 
 
 
   Making
   Annotations
 
 
 
 If you're
 needing to make annotations in the books you read, both apps
 offer some basic tools in this area. They including highlighting,
 bookmarking, and in the case of the Kindle, note taking.
 
 
 With each of
 these tools you press down on the word where you want to start
 highlighting and drag your finger across to where you want to end
 the highlight. In the Kindle app you tap on the upper corner of a
 page to bookmark it, whereas with iBooks you must use the
 highlighter tool as a bookmarker. Ironically, the tool is called
 Bookmark, but what you're really doing is highlighting.
 
 
 More useful information you can read from
 ipubsoftwordpress.com
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(no subject) 
 

 

 

 

 Battery Life is an important aspect of an iOS device. With

 the launch of iOS 5, many users feel the battery performance of

 their iDevices has decreased significantly and there have also

 been claims that the battery life is below par than stated by

 Apple officially. However, the new Cydia tweak by Akhil Tolani

 may be a savior for those who use are fed up of their iDevices

 powering off when they want to use it the most. The tweak is

 called

 PowerSaver. Read on for more details.

 

 This new tweaks allows users to carry out pre-defined

 actions when a particular percent level of the battery is

 triggered. The usual iOS system shows an on-screen alert when the

 battery goes down to 20% then 10%. Well, for me this isn't

 something that users didn't know already. What PowerSaver does is

 that allows certain power processes and system settings to switch

 off at a certain percentage thereby extending the

 functionality.

 

 

 With PowerSaver, many actions are available, such as

 turning off Wi-Fi, rebooting or respringing the device, turning

 off the Bluetooth and much more. A great benefit is that it

 doesn't require additional battery to function, so it is pretty

 useful.

 

 

 The tweak also supports up to fourteen unique alarms. Users

 can tigger any of them when the battery reaches a certain level.

 E.g. you can ask the tweak to turn off the Bluetooth when the

 battery level reaches 20%. If you can get a hold off when to turn

 off the right functions and how to work out the key levels, there

 is a high probability that you'll get a prolonged battery

 life.

 

 

 More interesting guide:

 top



 five iphone music apps
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3 alternatives to copy text from pdf to word 
 

 Have you ever met the problem: When you are looking for

 some material, such as paper, some are very decent information

 for you, and can't wait to copy them into word, but

 unfortunately, they are both pdf formats. How can we copy the key

 datas into word?

 

 

 Indeed, it is not a perfect method to copy text from PDF

 and paste into MS Word directly. Why? Imagine this: When you want

 to copy a large portion of content from a single PDF or from PDF

 with several or even probably hundreds of or thousands of pages,

 copying and pasting would probably takes you hours of longer to

 finish the tedious, boring work.

 

 

 How can we settle this problem rightly? In this article, I

 will introduce 3 ways to you for copying text from PDF to

 Word.

 

 

 Copy Text from PDF to Word with PDF to

 Text Converter

 

 

 In this way, you'll need another program called iStonsoft

 PDF

 to Text Converter, a program that will export your PDF

 documents to plain text (.txt) files. It supports batch and

 partial conversion. And the operation steps are similar with the

 PDF to Word Converter in the first way. The only difference is,

 after converting PDF to TXT, you need to manually copy the

 converted TXT contents to MS word for viewing, editing, etc. More

 information and tutorial of PDF to Text Converter you can refer

 to: How to change PDF to Text.



 

 

 Copy Text from PDF to Word with PDF

 Editor

 

 

 In this way, the tool you need is

 PDF Editor,

 which enables you to directly copy text from PDF without

 converting. It will be as easy as you do in MS Word program. With

 PDF Editor, you can get more abilities to edit text in PDF

 document, such as text, font sizes, images and more.

 

 

 

 

 

 Copy Text from PDF to Word with PDF to

 Word Converter

 

 

 In this way, you'll need to rely on this program: iStonsoft

 

 PDF

 to Word Converter. It can convert PDF files to Word DOCX

 format with fast speed and great quality. It also supports batch

 and partial conversion. Within 3 simple steps, you can finish the

 conversion, and you'll be able to copy text from PDF to Word

 easily.

 

 

 STEP 1 : Import the PDF files.

 Just drag and drop them into the panel. You can add

 multiple files at one time.

 

 

 STEP 2 : Make customizations.

 You can set pages or page ranges for converting specific

 pages. And click Browse button to customize the output

 folder.

 

 

 STEP 3 : Output PDF to Word

 Start converting by clicking Convert button. Or right click

 to convert selected.
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The different sorts of iPad apps development 
iPad is the best tablet existing in the market with amazing

touch screen, great user interface design and extraordinary

features. It combines the use of laptop, mobile phone and gaming

over its single platform and therefore on the price factor; it

proves costly. Still buying an iPad is a dream of almost everyone

who is in love with technology. The success of iPad development had

lead many IT companies to introduce this service over their desk.

It is one of the best ways to grow your market as Apple Apps are

downloaded on maximum numbers across the globe.

 

 

 

 

There are different kinds of iPad apps development carried

out by the iOS developers, which are listed below.

 

 

iPad social media apps development: Can you

imagine your life without social networking anymore? Social media

sites like Facebook, Twitter, MySpace, YouTube, etc are visited by

the millions of internet users from different devices like PC,

laptop, mobile phone, tablets, iPad, etc for twice or thrice a day

and even more. iPad apps development for social sites help the user

in connecting with their desired social networking channel without

opening the browser as the app directly connects the browser.

 

 

iPad news application: In today's world none can

survive a moment without getting continuous updates about the

world. Either it is technology, entertainment, global news, local

news and even more; iPad application development for news aid with

constant updates for both national as well as international world.

 

Entertainment Apps: These apps are designed to kill your time



in the simplest way. iPad development for entertainment apps

include the latest Hollywood news, actor/actress gossips, wardrobe

secrets of fashion models and even more. These apps are downloaded

on great numbers as it aids with spicy gossips and entertainment.

 

 

iPad games development: Games are the first thing

that attracts the kids, teenagers, adults, businessmen and even

baby boomers. The gaming factor entertains anyone as it takes the

user in a different world. iPad apps development for games is

carried using 2D/3D technology and this makes the gaming experience

more powerful and entertaining.

 

 

Other Apps for iPad: There are many other iPad

development on applications like travel, weather, stock alert,

business news, sports, search tool, productivity, videos such as

how to

Enjoy

videos on your new ipad with with PlayerXtreme etc; to name a

few. All these applications are truly designed to help the user in

meeting their requirements. Almost the applications are run using

internet connection and hence the user is asked to use Wi-Fi for

having the better performance of the applications.
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The Multiple Choice of Converting PDF to Word 
 
 
  
 
 As we know, PDF files are very popular in nowadays daily work,
 especially for those people who have to deal with bunches of
 contract or key information. But, once we find some errors of PDF
 files, we have to make some changes of them, so it is a must for
 us to convert PDF files to some changeable formats such as word,
 excel, ppt etc.
 In this article, we just take how to convert pdf to word for
 an example, if you are also met the problem about how to turn pdf
 to word, you can have a careful reading here.



 
 Tips: If you are a mac user, you maybe
 interested in
 how to
 convert pdf to jpeg on mac
 
 
 Way one:
 Gmail, QQ mailboxes, view the PDF directly
 In the early time, Gmail has solved the problem about viewing
 PDF files. Send the  PDF as an attachment to Gmail mailbox,
 click on the "view" or "view" link in the annex side with the
 online PDF reader, click on the "plain html" link page format,
 which can display pdf content. If you need a certain doc format,
 please copy the html content to Word.
 In the QQ mailbox, there are also link to view the PDF
 attachments just similar to the Gamil, next to the PDF
 attachments. But it lack of text formatting. In addition, this
 conversion can also cracks PDF restrictions and break the limit
 of copying the content.
 
 Advantages: Fast, trusted.
 
 Disadvantages: PDF picture seems to have a
 problem.
 
 Way Two: Known as the most accurate
 pdftoword.com online conversion
 [img: pdf to word] PDFtoWord.com is claimed to be the most
 accurate pdf to word file conversion, from the famous PDF
 solutions provider NitroPDF.
 PDFtoWord.com online application, completely free, easy to
 use:
 - Access pdftoword.com: â  upload pdf
 → â¡ selected format (doc / rtf) →
 â¢ input to receive E-mail;
 - Enter mailbox: check your word document after
 conversion.
 
 
 Way Three:
 More Online PDF to Word application
 Computer plaything had done a test, comparing 4 online
 applications. However, due to the special requirements of the
 test - 11MB, immediately converted - only the best applications
 to reach the target. Therefore, no conversion quality comparison.



 http://www.zamzar.com/, multi-format conversion website,
 document limit 1GB, conversion work need to wait in line.
 http://www.pdftoword.com/, upper limit of 10MB, need to
 wait.
 http://convertpdftoword.net, the file name must be in
 English.
 http://www.pdfonline.com/pdf2word/index.asp, faster.
 
   Way Four: Shareware PDF to Word Converter
 
 Amacsoft
 PDF to Word for Mac is a small PDF conversion
 tool which is specially designed for converting PDF to Word doc
 on Mac OS X. Mac Users can edit PDF text, type on PDF files
 freely in Microsoft Word 2008 & 2010 after PDF to doc
 conversion. The PDF to Word Converter for Mac program is also
 perfectly compatible with Mac OS X Snow Leopard. (Guide:
 Convert
 PDF to DOC Mac)
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Best iPad Apps for 2012 Halloween Day 
 
 Hallowen Day is coming, are you ready for playing? How would
 you spent this special day? Go outside e.g. attending costume
 parties, carving jack-o'-lanterns, lighting bonfires, visiting
 haunted attractions, playing pranks or watching horror films? Or
 just stay home? Ok, maybe both of them are alternative, after all
 not all of us are time-affordable. If you are a typical
 stay-at-home type, you must make best use of your various devices
 to spend the Hollowen Day. In this article, we can share you some
 apps for your ipad.
 
   Carve-A-Pumpkin
 
 From Parents Magazine, this app gives your child a safe, no
 sharp object, way of carving a Halloween pumpkin. You can choose
 from 5 different pumpkin styles, then carve your design. You can
 carve either by hand (or finger) or pick from the library of



 wacky eyes, noses, and mouths. You can change the background and
 also decorate your pumpkin with stickers. When you're finished,
 you can add a message and share via email, Twitter or Facebook.
 You can also save to your photo album.
 
 Best Children's Halloween eBooks: Who Will Haunt My House
 on Halloween
 
 By Jerry Pallotta and illustrated by David Biedrzycki
 Spooky bats and zombies. Spiders and skinny skeletons. These are
 merely a few of the scary creatures that show up at a little
 girl's door to trick or treat on Halloween night. But you are
 they real? A suspenseful story and colorful illustrations get
 this to book an enjoyable Halloween choice.
 
   YouPlayer - YouTube Player for iOS6 1.0
 
 YouPlayer is a YouTube browser and player for iOS6.
 • Full universal app with support for the iPhone 5 and
 iPad.
 • Play any videos available for embedding including
 most music videos.
 Tips: If you want to transfer youtube video from ipad to
 computer or mac for sharing, you can
 come
 here to follow the detailed guide.
 
 
 creepOmatic
 With over 130 unique environment and melody combinations and
 over 30 spooky samples each experience you get from this free
 Halloween ipad apps will be unique. Perfect for Halloween
 parties, haunted houses or creeping out the neighborhood kids on
 Halloween night!
 
 
 Prize Claw Halloween HD
 Based on those claw machines that children love, the Prize
 Claw game has been around, but now they have created a Halloween
 edition. There are new prices, powers and puzzle pieces. Players
 can earn bonuses daily and customize the app's machine, claws and
 joysticks. As seasons change, new machines and prizes will be
 added through updates. This app has in-app purchases. Want to
 start clawing?
 
   Halloween Mask My Face



 
 Halloween Mask My Face is the best free Halloween iPad apps
 which allow you to place a variety of Halloween masks onto images
 and save them to share with family and friends! With this top
 best iPad app for Halloween you can add a Halloween mask to any
 image for free!
 
   More information about Halloween you maybe interested
   in:
  
   Best
   Halloween ebooks for children
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Make a Round Review of iPad Mini 
 
Abstract: Well, just as the various news reported,
Apple today has finally announced the iPad Mini, a 7.9-inch version
of its immensely popular iPad. A completely new iPad design that is
23 percent thinner and 53 percent lighter than the third generation
iPad. The new iPad mini features a stunning 7.9-inch
Multi-Touch™ display, FaceTime HD and iSight cameras,
ultrafast wireless performance¹ and an incredible 10 hours of
battery life²âevery inch an iPad, yet in a
revolutionary design you can hold in one hand.
 
 
However, faced with this new product, where can we learn from
the ipad mini? Whether it is worth to buying, whether it is ok for
the movie fans to watch video on line, whether it is ok for us to
take beautiful photos, etc. All these questions are needed to
consider.  In the following article, you can have a good learn
of it.
 
 
 
 iPad Mini: Price and Shipment
 



 
 
Apple is delivering an iPad Mini with a starting price tag of
$329. The new device, a 7.9-inch version of the 10-inch iPad
tablet, goes on sale Friday and ships on November 2, Apple
announced from the California Theatre in San Jose, Calif. The $329
iPad Mini will have 16GB of storage and will be Wi-Fi only.
 
 
 
 iPad Mini: Screen
 
 
 
The LED-backlit screen looks fantastic on the 7.9-inch display.
Colours are vivid, text is pin sharp, web pages render quickly and,
because there's almost a 4:3 ratio going on, you get a lot of
content on page. It feels squarer than the bigger iPad, but
definitely works as, arguably, a better mobile experience than its
bigger brother. Screen resolution is 1024x768 resolution at 163ppi
- same as the iPad 2 - so apps all work without any letter-boxing.
So, given that, the ipad mini is really a good choice for us to
watch video on ipad. Here is the
best
video to ipad mini converter
to convert video to ipad supported format.
 
 
 
 iPad Mini: Camera
 
 
 
The back-facing 5MP iSight camera is similar to what we've seen
on bigger iPads. Taking pictures or video is easier with one hand,
purely because of the Mini's size. In the wild, it's much more
manageable than the iPad. but 1080p video is more impressive. With
stabilisation kicking in, plus integration with iOS6, getting video
content online will be easy. (Hot link:
How
to make slideshow for ipad mini
)
 
 
 
 iPad mini Connectivity



 
 
 
A key feature of this new tiny tablet is that it sports Apple's
new Lightning connector which debuted on the iPhone 5. This is much
smaller than the 30-pin connector as used on all previous iPads and
iPhones but there has been much gnashing and wailing over the fact
it requires investing in either new docks, cables and other
accessories. In particular there's uproar that the iPhone 5 doesn't
include the £25 adapter that converts Lightning back to the
old connector type, and so it is here. But, at least with the iPad
mini and newly updated iPad 3 Lightning the new connectors will
start to become more common, so finding a spare in an emergency
will be easier.
 
 
 
 iPad Mini: Performance
 
 
 
Hard to tell in the 15 mins that we had with the iPad Mini, but
the A5 processor powered apps, games and websites along very
smoothly. It's loaded with LTE, which means you'll be able to use
it on EE's 4G network in the UK. 5GHz WiFi means super fast
browsing with compatible routers, too. Our experience was
impressive and we can't wait to give it a proper run in the coming
weeks.
 
 
 
More ipad mini tips you maybe interested in:
 
 
How to add files to ipad mini from mac
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However, faced with this new product, where can we learn from
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the movie fans to watch video on line, whether it is ok for us to
take beautiful photos, etc. All these questions are needed to
consider.  In the following article, you can have a good learn
of it.
 
 
iPad Mini: Price and Shipment
 
Apple is delivering an iPad Mini with a starting price tag of
$329. The new device, a 7.9-inch version of the 10-inch iPad
tablet, goes on sale Friday and ships on November 2, Apple
announced from the California Theatre in San Jose, Calif. The $329
iPad Mini will have 16GB of storage and will be Wi-Fi only.
 
 
iPad Mini: Screen
 
The LED-backlit screen looks fantastic on the 7.9-inch
display. Colours are vivid, text is pin sharp, web pages render
quickly and, because there's almost a 4:3 ratio going on, you get a
lot of content on page. It feels squarer than the bigger iPad, but
definitely works as, arguably, a better mobile experience than its
bigger brother. Screen resolution is 1024x768 resolution at 163ppi
- same as the iPad 2 - so apps all work without any letter-boxing.
So, given that, the ipad mini is really a good choice for us to
watch video on ipad. Here is the
best
video to ipad mini converter to convert video to ipad supported
format.
 
 
iPad Mini: Camera
 



The back-facing 5MP iSight camera is similar to what we've
seen on bigger iPads. Taking pictures or video is easier with one
hand, purely because of the Mini's size. In the wild, it's much
more manageable than the iPad. but 1080p video is more impressive.
With stabilisation kicking in, plus integration with iOS6, getting
video content online will be easy. (Hot link:
How
to make slideshow for ipad mini)
 
 
iPad mini Connectivity
 
A key feature of this new tiny tablet is that it sports
Apple's new Lightning connector which debuted on the iPhone 5. This
is much smaller than the 30-pin connector as used on all previous
iPads and iPhones but there has been much gnashing and wailing over
the fact it requires investing in either new docks, cables and
other accessories. In particular there's uproar that the iPhone 5
doesn't include the £25 adapter that converts Lightning back
to the old connector type, and so it is here. But, at least with
the iPad mini and newly updated iPad 3 Lightning the new connectors
will start to become more common, so finding a spare in an
emergency will be easier.
 
 
iPad Mini: Performance
 
Hard to tell in the 15 mins that we had with the iPad Mini,
but the A5 processor powered apps, games and websites along very
smoothly. It's loaded with LTE, which means you'll be able to use
it on EE's 4G network in the UK. 5GHz WiFi means super fast
browsing with compatible routers, too. Our experience was
impressive and we can't wait to give it a proper run in the coming
weeks.
 
 
More ipad mini tips you maybe interested in:
 
 
How to add files to ipad mini from mac
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Merge PDF Documents Easily and for Free ! 
There is no doubt that sometimes, we really need to makes some

change of our pdf files, for example, converting, editing, merging,

splitting etc. When we have come across the problem about merging

the big size of PDF files, how can we do it in the quickest time

then? It is never to be harder for you from now, we can easily

merge PDF files into one with PDF editing software or the magic PDF

merger programs.

 

This

PDF Editing software is the best tool

to edit PDF document. Besides merging PDF files into one larger one

file, it allows you freely edit native and scanned PDF files. You

can add, delete, adjust text and image easily. Additionally, you

can convert PDF files to many editable PDF files like Word,

PowerPoint, Excel and etc. You can also make PDF files from other

files and protect your files with password. In conclusion, it's a

tool you never want to miss.

 

This service enables you to combine PDF documents into a

single one, free of charge. All you need to do is select the PDF

documents that you want to merge together on your computer and

click a button, as instructed step-by-step below.

 

 

Guide to Merge PDF Files into One File with PDF Editing

Software

 

 

Step 1: Launch the PDF editing software on your

computer

 

Download and install the PDF editing software on your

computer. Then you can run it. You will see an intuitive interface.

You can edit your PDF files by choosing tools from toolbar on the

top menu.

 

 

Step 2: Select "Pages" tab on the toolbar

 

You can find file and page mangement tool in Pages Tap

toolbar. Click the Pages Tab > Documents, Click on the "Merge

Document" icon. You will see a pop up window as below.



 

Step 3: Add PDF files

 

 

Click the "Add Documents... " button to add all the PDF files

you would like to merge. You can directly drag and drop PDF files

into this software. Before making merge, you can click "Move Up" or

"Move Down" to arrange the order of PDF files. You can also click

"Remove" button to remove PDF files. Then you can click the "Merge"

button at the bottom. When the software finishes merging PDF files,

you can open the new PDF file in this software.

 

 

More suggested reading from here:

 

 

How to convert ppt to pdf

 

Easy way to convert text to epub on

mac
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